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Information Security Objectives

Security is 
lifestyle!

Think Safe. 
Think Secure.
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What are the 
Information Security Objectives?

NUS Restricted

Accessible by authorized personnel.

Accessible when required.

Preserve                      Confidentiality                         Integrity                          Availability                               

Accurate and complete.

Source: IT Security Policy Chapter 1- Introduction to IT Security Policy, Section 2

Of                         Information                           and                                  Information Systems
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Confidentiality Breach

Initial investigations showed that one SingHealth front-end workstation 
was infected with malware through which the hackers gained access to 
the data base. The data theft happened between June 27, 2018, and July 
4, 2018.

Personal info of 1.5m SingHealth patients, 
including PM Lee, stolen in Singapore's worst 
cyber attack

https://www.straitstimes.com/singapore/personal-info-of-15m-singhealth-patients-including-pm-lee-stolen-in-singapores-most



Copyright © NUS 2017

Public
NUS Restricted

Confidentiality Breach
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Integrity Breach
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Availability Breach

Surce: https://www.tripwire.com/state-of-security/latest-security-news/1-65m-users-victimized-cryptocurrency-
miner-threats-far-2017/
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Over the course of the current week, WordPress sites around the 
globe have been the targets of a massive brute-force campaign 
during which hackers attempted to guess admin account logins 
in order to install a Monero miner on compromised sites.
Source: https://www.bleepingcomputer.com/news/security/massive-brute-force-attack-infects-
wordpress-sites-with-monero-miners/
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Answer: Ensure the confidentiality, integrity and 
availability of information system and information.
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Information Security Policies

Think Good practice
Implement Good practice
Protect our Data and System
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Roles and Responsibilities in 
Information Security

System 
Owner

User IT Staff

Responsible to Comply to Policies, Circulars, Advisories

Roles
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Overview of Information Security Policies

IT Security

Acceptable Use (for NUS IT resources) 

Software Terms of use

Software Management

Mobile Device

Guideline for personal computer and equipment

Data Management

Guideline to classification and protection of University data 

Cloud

Guidelines for Acceptable Use (of NUS IT resources) 
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Answer: Guidelines for Acceptable Use
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Answer: No, with revised AUP (version 4.2 dated 1 Feb 
2018), all Executive and Professional staff, Non-
Academic staff and Senior Academic staff shall only use 
their University Assigned Email Accounts for official 
correspondence.
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Policy How does it apply to me? 

Chapters /Clauses Use Cases

1 IT Security • Chp 4 - Access Control Security 
• Chp 10 – System Development 

and Maintenance
• Chp 6 - Physical and 

Environmental Security 

System Owner
• Review user accounts and access 

rights on Information System
• Request for Security Assessment 
User
• Lock screen when you walk  

away from your computer
• Report security incident to 

ccecert@nus.edu.sg immediately

2 Acceptable 
Use for IT 
resources 

• Computer Misuse and 
Cybersecurity Act

• Spam Control Act
• Copyright Act 

• No sharing of account or 
password

• No spamming

Applying Information Security Policies

mailto:ccecert@nus.edu.sg
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Cap Legislative Act Brief Description

50A Computer Misuse and Cybersecurity Act Unauthorized access or modification of computer 
program/data

88 The Electronic Transaction Act Preservation of the integrity and reliability of 
electronic record

311A Spam Control Act
https://www.ida.gov.sg/Policies-and-Regulations/Acts-and-Regulations/Spam-
Control-Framework

Unsolicited communication in bulk either email or 
mobile

97 The Evidence (Computer Output) Regulations in 
Chapter 97 of the Evidence Act

Admissible evidence for court case (e.g. relevant facts 
not opinions)

2012 The Personal Data Protection Act
https://www.pdpc.gov.sg/docs/default-source/publications-edu-materials/what-
you-need-to-know-about-pdpa-v1-0.pdf?sfvrsn=4

Protection of personal data

63 Copyright Act Protection of intellectual work

221 Patent Act Protection of invention

332 Trademark Act Protection of branding 

338 Undesirable Publications Act Prohibited publication that may be obscene, 
objectionable, etc

Legislation Acts
http://statutes.agc.gov.sg/aol/search/display/view.w3p;ident=a0823194-a6f3-481d-898a-

7854557b85e7;page=0;query=CapAct%3A88%20Type%3Auact,areved;rec=1;resUrl=http%3A%2F%2Fstatutes.agc.gov.sg%2Faol%2Fsearch%2Fsummary
%2Fresults.w3p%3Bquery%3DCapAct%253A88%2520Type%253Auact,areved#legis

https://www.pdpc.gov.sg/-/media/Files/PDPC/PDF-Files/Advisory-Guidelines/advisory-guidelines-on-key-concepts-in-the-pdpa-(270717).pdf

http://statutes.agc.gov.sg/aol/search/display/view.w3p;ident=a0823194-a6f3-481d-898a-7854557b85e7;page=0;query=CapAct:88%20Type:uact,areved;rec=1;resUrl=http:/statutes.agc.gov.sg/aol/search/summary/results.w3p;query=CapAct:88%20Type:uact,areved#legis
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Answer: No, you are liable for all actions performed 
using the account
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In the incident, which took 
place on Dec 26, 2015, an 
unknown perpetrator used 
valid admin account 
credentials to log in to a 
server that held personal 
customer data.

It found that Orchard Turn Developments did not have any policy 
to prohibit the sharing of admin account credentials, or to 
enforce the periodic expiry and renewal of these. Instead, it had 
only one admin account, which was shared among four 
authorised users. Source: CNA @ Jul 2017
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Policy How does it apply to me? 

Chapters /Clauses Use Cases
3 Software 

Terms of use
• Para 3 – Appropriate use of 

NUS Software
• Install licensed Software on NUS 

computers for use only during 
course of employment with NUS

4 Software 
Management

• Para 3 (iii) - Policy • Software used are 
appropriately licensed and 
inventoried 

5 Guideline for 
personal 
computer 
and 
equipment

• Para 1.1 Qualified 
Corporate Mobile Devices

• Use Qualified Corporate 
Devices

https://staffportal.nus.edu.sg/st
affportal/it/equipmenttender

Applying Information Security Policies

https://staffportal.nus.edu.sg/staffportal/it/equipmenttender
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Software Audit Circular dated 20thOct2016
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Answer: Most shareware are free for personal use and 
not for commercial use. For example, malwarebyte and 
Ccleaner. Read the terms and conditions to verify.
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SN Policy How does it apply to me? 

Chapters /Clauses Use Cases

7 Data 
Management

• Chp 3- Data Classification
• Chp 4 – Data Administration 

(Data Collection, Sharing, 
Reporting Loss)

• Classify the University Data 
handled (NUS Confidential, NUS 
Restricted, NUS Internal, Public)

• Report data loss or leakage cases 
immediately to cceda@nus.edu.sg

8 Guideline to 
classification 
and protection 
of University 
data 

• Section D – Measures to 
protect University Data

• Secure data on laptop (using EFS), 
external USB  storage (using 
Bitlocker) and email (e.g. using 
encrypted attachment sent via 
email)

9 Cloud Policy • Para 5.5 – Self Subscribed 
cloud service (for public or 
NUS Internal)

• Para 6 – Enterprise Subscribed 
cloud service (NUS 
Confidential, NUS Restricted)

• Subscribe to appropriate cloud 
services depending on the data 
classification and risk assessment 
(contact NUS IT Cloud 
Policy@nus.edu.sg for cloud 
assessment)

Applying Information Security Policies
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Answer: 
Contact NUS IT Cloud Policy@nus.edu.sg.
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Answer: IT Security Policy Chap 1 Clause 3.4.1



Copyright © NUS 2017

Public
NUS Restricted

Answer: Yes, IT Security Policy Chap 1 Clause 3.6.3
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Data Protection Measures

Security is 
lifestyle!

Think Safe. 
Think Secure.
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Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose

Data Lifecycle & 
Data Protection Best Practices

Classify data as 
NUS-Internal, 
NUS-Restricted or 
NUS-Confidential.
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NUS-Confidential Data

Documents, information, or materials which are sensitive or critical, including proprietary 
information, for use within NUS by authorised personnel on a need-to-know basis. Release 
of NUS Confidential data may result in financial loss, potential litigation and severe damage 
to the reputation and interests of NUS, or the individual or entity to which the documents, 
information or materials relate. 

Examples:-
• Staff salary 
• Staff appraisal
• Examination marks/grades (including CAP and SAP) and examination questions 
• Admission data (results, admission points, criminal records)
• Medical records (including medical and case history, diagnosis, case note, etc) 
• Donor records 
• Credit card/Bank account information (including bank account number, name of payee, 

amount, etc. excluding staff number) 
• NRIC/FIN (including unique identification number such as Singapore NRIC, FIN, 

employment pass no., work permit no., student pass no., etc) 
• Information relating to significant University initiatives or collaborations which are 

being negotiated 
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NUS-Restricted Data
Documents, information, or materials other than those classified as NUS Confidential 
which are for use within NUS by authorised personnel on a need-to-know basis, including 
those which NUS has a contractual obligation to protect and all personal data as defined 
and classified in the DMP or any other applicable policy, procedure or guideline. Release of 
NUS Restricted data may involve damage to the reputation and interests of NUS, or the 
individual or entity to which the documents, information or materials relate. 

Examples:-
• Student, current and ex-staff and alumni records (e.g. alumni employment details, 

including aggregated, banded and/or de-identified salary information of alumni and 
graduates), research grant information and data, certain management information and 
reports, and information covered by confidentiality obligations. 

• Personal Data
a. Identification numbers (staff number, matriculation number) 
b. Personal contact information (phone numbers, emails and addresses) 
c. Employment details (including employer, designation, salary information of alumni 
and graduates, previous employment details of NUS staff) 
d. Information on spouse, children and next-of kin 
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Answer: For example, Label document header and/or footer with 
NUS Confidential, NUS Restricted and NUS Internal
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How do we classify data?

Classify data: 
e.g. Label the 
document 
header and 
footer with 
appropriate 
data 
classification

NUS Confidential

NUS Confidential

e.g. Tan Ah Kou
S7712345B
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Data Lifecycle & 
Data Protection Best Practices

Encrypt NUS-Confidential data
store on Laptop using 
Encrypting File System (EFS) 

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose
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Data Encryption & Decryption

Source: https://www.quora.com/What-are-encryption-and-decryption

00113 3
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Sony’s Data Leakage

Source : 
https://www.riskbasedsecurity.com/2014/12/a-breakdown-and-analysis-of-the-december-2014-sony-hack/
https://www.entrepreneur.com/article/240517

https://www.riskbasedsecurity.com/2014/12/a-breakdown-and-analysis-of-the-december-2014-sony-hack/
https://www.entrepreneur.com/article/240517
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Answer: Encrypt the data
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Encrypt Windows Folders (using EFS)

NUS Restricted

Picture: ZDNET

Right click on folder to encrypt. Select the option, “Properties”.

Note: EFS can encrypt the folders and files

reference:%20http://www.zdnet.com/article/how-to-turn-on-iphone-ipad-encryption-in-one-minute/
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Back up  EFS Key
 Type certmgr.msc in the Search box and hit the ENTER key.
 Select Personal Folder and Click Certificates. Select userID.

Reference: https://nusit.nus.edu.sg/its/resources/landing/
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Back up  EFS Key
 Click Action -> All Tasks -> Export.
 Click Next on Certification Export Wizard 
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Back up EFS Key
 Select “Yes, export the private key”
 Click Next on Certification Export Wizard 
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Back up EFS Key
 Select Password option and Enter Password. Click Next on Certification Export Wizard.
 Click on Browse button, select the folder and enter filename for the EFS Key.
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Back up EFS Key
 Click Finish on Certification Export Wizard.
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Back up  EFS Key

 Always copy EFS key to another device such as USB.
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Answer: Data cannot be decrypted.
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Data Lifecycle & 
Data Protection Best Practices

Access data securely:
• Use VPN to access NUS system 

and data
• Use https website
• …

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose
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Use VPN to access 
NUS System & Data off Campus

NUS Restricted

VPN -https://comcen.nus.edu.sg/qat4/wp-content/uploads/downloads/nvpn/nVPN-config-guide-for-staff.pdf

1

2

3

4

https://comcen.nus.edu.sg/qat4/wp-content/uploads/downloads/nvpn/nVPN-config-guide-for-staff.pdf
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Use https website

NUS Restricted

Source: https://blog.easynews.com/http-vs-https-whats-the-difference/
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Do not store password in browser

NUS Restricted

Source: https://www.pandasecurity.com/mediacenter/security/browser-saves-
password-secure/
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What are the Best Practices ?

NUS Restricted

2

Log off from browser application after using it.

3 Never remember password in browser.

4

Use https website for sensitive transactions 
(e.g. requires login)

1 Use VPN to access NUS System and data off 
campus.
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Data Lifecycle & 
Data Protection Best Practices

Share data securely: Exchanging dataover email, portable storage, 
shared folders

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose
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Sending Out Personal Data by Mistake 

NUS Restricted

Source (Mar 1, 2017):  http://www.straitstimes.com/singapore/take-steps-to-secure-online-accounts-experts-urge

http://www.straitstimes.com/singapore/take-steps-to-secure-online-accounts-experts-urge
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What are the Best Practices ?

NUS Restricted

1 Check that the recipient email address is correct

2 Encrypt the file with password using Winzip

3 Set delay email delivery
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Encrypt Files with Password 
using Winzip

NUS Restricted
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Encrypt Files with Password 
using Winzip

NUS Restricted

Configure your Winzip encryption settings to AES 256
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Encrypt File Using Protect Document

NUS Restricted

Go to File-> Protect Document-> Encrypt with password
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Deferment of Email Delivery

NUS Restricted

From outlook client, go to File->Rules and Alerts->New Rule
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Deferment of Email Delivery

NUS Restricted

Select the option, “Apply rule on message I 
send”. Click the button, “Next”

Select the option, “Apply on this computer 
only”. Click the button, “Next”
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Deferment of Email Delivery

NUS Restricted

Select the option, “Defer delivery by a number of minutes”. Click on the hyperlink, “ a number of” and 
specify the number of minutes to delay. Click the button, “Finish”
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What is Open Shares

This a user misconfiguration 
where shared folder permission is 
set to allow EVERYONE to have 
full access. It provides a very easy 
and effective way for attackers to 
browse and steal the (sensitive) 
data without any hacking tool or 
skill. 

What should I DO
You should do a self-check on your 
computer to discover if there is any 
Open Shares or folder that has been 
shared unintentionally, and remove 
it immediately. 

Sharing out Confidential Data Unknowingly
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Answer: 
Content within folders can be read, update and delete by everyone.
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Remove Insecure Share Folders

NUS Restricted

Share to only authorized party 
and not everyone

1

2

3

https://comcen.nus.edu.sg/services/it_security/data-security/check-and-remove-insecure-shared-folders/

https://comcen.nus.edu.sg/services/it_security/data-security/check-and-remove-insecure-shared-folders
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Answer: Use Nbox, Sharepoint
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Answer: Yes, use Bitlocker. 
Refer to Guideline for Use, Classification and Protection of Data, 
Section D, Table 2.
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Enable Bit Locker

NUS Restricted

Source: https://nusit.nus.edu.sg/its/resources/bitlocker/install-bitlocker/
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Data Lifecycle & 
Data Protection Best Practices

Save important 
data from your 
computer to other 
device

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose



Copyright © NUS 2017

Public
NUS Restricted

https://nusit.nus.edu.sg/services/online_storage/nbox/
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Data Lifecycle & 
Data Protection Best Practices

Erase data 
securely

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose
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https://inetapps.nus.edu.sg/comcen/security/protect-data/secure-hard-disk-disposal-using-blancco.html

Secure Disposal of Hard Disk using Blancco Drive Eraser

It is mandatory to erase and destroy all University data 
stored in the storage media before disposal. For 
redeployment of hard disk, use Blancco for secure 
erasure. For disposal of any functional or non-functional 
hard disk that the data cannot be erased by Blancco, 
physical destruction would be required; shred/incinerate 
Solid State Drive (SSD) and degauss Hard Disk Drive 
(HDD).

NUS IT Co-op offers these services. You may contact them 
at 67792942 or email at coppc05@nus.edu.sg.

mailto:coppc05@nus.edu.sg
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Dispose Data Securely

NUS Restricted

Paper containing personal 
information must be shredded 
into small pieces and not 
dumped in unsecured bins.

Similarly, personal data 
stored on electronic media 
such as computer hard disks, 
USB drives or DVDs must be 
erased using specialised 
software to avoid accidental 
data leaks

Source: Straits Times 21 Jul 2016
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Answer: 
Report immediately your supervisor and to cceda@nus.edu.sg
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Trending Cyber Attacks Techniques: 
Phishing, Digital Currency Mining & 

Ransomware
Network
Servers

Applications
Clients (Users)
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Phishers use email to:

• Trick you into handing over your user
information so that they can gain
access to your system and network.

• Entice you to click on links that take you
to web sites that will infect your
computer with malware just by visiting
it.

• Deliver file attachments that can infect
your computer with malware.

“91% of Cyberattacks begins with Phishing Email “
– TrendMicro
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Phishing email getting more sophisticated

Source: https://www.todayonline.com/singapore/dbs-warns-phishing-site-targeting-bank-customers
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Phishing via SMS

NUS Restricted

https://www.businessinsider.sg/singhealth-fake-sms-messages-verify/

To verify the message, 
SingHealth said that its 
name will be reflected as 
the sender, and that it will 
not require credit card or 
other financial information: 
“Check that the SMS is 
from ‘SingHealth’ and that 
when you ‘click’, it brings 
you to the SingHealth
website.”
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Phishing via SMS

NUS Restricted

Source: https://www.csa.gov.sg/singcert/news/advisories-alerts/protecting-your-personal-data-2018
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Phishing via Phone Calls with modified Caller ID

NUS Restricted

Singapore Airlines warns of phishing scams offering free air 
tickets

https://www.channelnewsasia.com/news/singapore/singapore-airlines-warns-of-
phishing-scams-offering-free-air-9513474

Beware of emails, calls, 
messages, surveys and 
contests that claim to be 
from Singapore Airlines (SIA) 
and which offer free air 
tickets or credits, said the 
flag carrier on Wednesday 
(Dec 20).

Published Dec 20, 2017

To appear more authentic, some scammers modify their caller ID to imitate 
SIA's official telephone numbers. … The airline also advised customers to be 
on the alert for phishing websites that appear similar to the official 
SIA website, and to exercise caution in sharing their personal details online.
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Phishing via Email, SMS, whatsApp

NUS Restricted

Source: Straits Times 7 Sep 2017

.. e-mail address, mobile number 
and date of birth were exposed

AXA made a police report, and 
advised customers to do the same if 
they had inadvertently disclosed 
personal data as a result of phishing 
attempts in the last few months as it 
could be connected to the AXA 
hacking incident

This method, known as phishing, can 
be executed via e-mail, SMS and 
WhatsApp - now that hackers have 
users' e-mail address and mobile 
number
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How to identify spoofed account?
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How to identify spoofed account?
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1 Look out for ”Sender Not Verified” in the subject

2 Look out for digital signature

3 Type the email address at the “to” field and click 
on check names

How to identify spoofed account?
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Answer:
Yes, the account could be compromised. Report any suspicious 
email using Phishing button. 
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Phishing email 
targeting NUS
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Evolving Phishing Email Techniques

NUS Restricted

Source: https://www.wordfence.com/blog/2017/01/gmail-phishing-data-uri/

…. “The attackers log in to 
your account immediately 
once they get the credentials, 
and they use one of your 
actual attachments, along with 
one of your actual subject 
lines, and send it to people in 
your contact list
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Phishing Email from Legitimate Account

….Spear phishing is the fraudulent practice of sending e-mail 
from trusted sender, to trick targeted individual to reveal 
information, click on malware infected link or attachment.

Image included directly from NUS website

Valid NUS website address

Mouse over link show non NUS website



Copyright © NUS 2017

Public

Phishing Email from Legitimate Account

NUS Restricted

Mouse Over 
Hyperlink
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How to mouse over link on mobile phone?

Source: http://osxdaily.com/2014/02/20/preview-link-url-safari-ios/



Copyright © NUS 2017

Public
NUS Restricted

1

2 Mouse over the the URL. Is it familiar? 
e.g. NUS domain  nus.edu.sg 

Spot a Phishing Email in 3 steps

Are you expecting the email? 

3 Use link checker to check if the links are safe. 

e.g. organization

e.g. industry or country
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Answer:
Use online scanner or link checker to help determine if a website is malicious such as 
https://www.virustotal.com, https://www.phishtank.com/, etc

https://www.virustotal.com/
https://www.phishtank.com/
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https://www.virustotal.com/
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https://www.phishtank.com/
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https://safeweb.norton.com/
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https://transparencyreport.google.com/safe-browsing/search
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Answer: Check out haveibeenpwned.com or pastebin.com
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You can try key your email account over here

https://haveibeenpwned.com/
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Answer: Reset password. Run anti-virus scan.
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What is the impact of Phishing?

380,000 Uber users hit in Singapore's largest data breach

Personal information of 380,000 
people here, including names, e-mail 
addresses and mobile phone 
numbers, were exposed when Uber 
was hacked last year, the ride-sharing 
company disclosed yesterday -
owning up to what is Singapore's 
largest data breach to date.

…the company has not seen evidence of fraud or misuse tied to the 
incident. But it did encourage users to report anything unusual 
related to their accounts.

http://www.straitstimes.com/singapore/380000-uber-users-hit-in-spores-largest-data-breach

Published Dec 16, 2017
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What is the impact of Phishing?
https://www.wired.com/story/uber-paid-off-hackers-to-hide-a-57-million-user-data-breach/

Published Nov 21, 2017

According to Bloomberg, Uber's 2016 
breach occurred when hackers discovered 
that the company's developers had 
published code that included their 
usernames and passwords on a private 
account of the software repository 
Github.

Those credentials gave the hackers immediate access to the 
developers' privileged accounts on Uber's network, and with it, 
access to sensitive Uber servers hosted on Amazon's servers, 
including the rider and driver data they stole.

Hack Brief: Uber Paid Off Hackers to Hide a 57-Million 
User Data Breach
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Answer: No, attacker may reuse same password to 
compromise your other account. 
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Source: https://venturebeat.com/2016/06/05/mark-zuckerbergs-twitter-and-pinterests-accounts-hacked-linkedin-password-
dump-likely-to-blame/
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Phishing Reporter Button Launch
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Answer: 
We are in the process of removing old Phishing reporter button             and 
rolling out new Phishing reporter button          . No action required on your 
part.
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Answer: 
Report suspicious email using Phishing Reporter Button or
Email to ITCARE@nus.edu.sg

mailto:ITCARE@nus.edu.sg
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Best Practices: Account & Password

NUS Restricted

Use different account and password for social media and work.

1 Use strong password: minimum of twelve (12) 
characters in length and be comprised of letters, 
numbers, and/or special characters. 

2 Enable Two-Factor Authentication

3

Don’t remember password in web browser.4

Report suspicious email. Do not open the attachments 
or visit the websites.

5
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http://www.darkreading.com/vulnerabilities---threats/every-4-seconds-new-malware-is-born/d/d-id/1320474
http://nvlpubs.nist.gov/nistpubs/ir/2013/NIST.IR.7298r2.pdf
http://www.iso27001security.com/html/27032.html

Malware is Growing Fast

http://www.darkreading.com/vulnerabilities---threats/every-4-seconds-new-malware-is-born/d/d-id/1320474
http://nvlpubs.nist.gov/nistpubs/ir/2013/NIST.IR.7298r2.pdf
http://www.iso27001security.com/html/27032.html
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Answer: Digital Currency Mining.
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Digital Currency Mining

Bitcoins

Monero

https://www.coindesk.com/information/how-bitcoin-mining-works/

Get reward in form of digital currency 
by being the first to complete a 
mathematical computation. A lot of 
computing power is required to do 
this.

https://www.reuters.com/article/us-crypto-currencies-mining-analysis/computer-
shops-embrace-lucrative-business-outfitting-cryptocurrency-miners-
idUSKCN1G502L
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Published Dec 14, 2017

If you feel your Internet connection 
has been slower in the past few 
months, …you may be a victim of a 
new form of malware.

Cyber-security researchers have 
seen a spike in cryptocurrency 
mining malware this year, as well as 
a new trick called cryptojacking, 
where websites are infected with 
software that prompts visitors' 
computers to mine cryptocurrency 
when they visit the website.

http://www.straitstimes.com/singapore/slow-browsing-hackers-could-be-mining-bitcoin

Digital Currency Mining Malware
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How to block bitcoin mining websites

NUS Restricted

1. Go to C:\Windows\System32\Drivers

2. Edit the hosts file using notepad and enter the following values:

0.0.0.0 afminer.com
0.0.0.0 coin-have.com
0.0.0.0 coinerra.com
0.0.0.0 coinhive.com
0.0.0.0 coinnebula.com
0.0.0.0 crypto-loot.com
0.0.0.0 hashforcash.us
0.0.0.0 jescoin.com
0.0.0.0 ppoi.org

https://www.csa.gov.sg/singcert/news/advisories-alerts/alert-on-browser-based-digital-currency-mining
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Rise in Ransomware

NUS Restricted

http://www.straitstimes.com/singapore/noticecable-rise-in-ransomware-infections-in-singapore-singcert/
https://www.csa.gov.sg/singcert/news/advisories-alerts/ransomware

http://www.straitstimes.com/singapore/noticecable-rise-in-ransomware-infections-in-singapore-singcert/
https://www.csa.gov.sg/singcert/news/advisories-alerts/ransomware
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Ransomware

NUS Restricted

Source: Symantec @ Aug 2015
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WannaCry Ransomware

NUS Restricted

Victims either did not apply a software 
patch, released in March (2017), to fix 
a known flaw in their Microsoft 
Windows systems, or were using old, 
unsupported systems such as 
Windows XP or Windows Server 2003.

Users might have initially been infected by clicking on a 
bogus link or attachment in the e-mail. Then the worm 
spreads to multiple machines over the intranet or Internet 
using a capability believed to have been developed by the 
United States National Security Agency - causing the 
attack to be unprecedented in scale by any ransomware

http://www.straitstimes.com/tech/wannacry-ransomware-critical-sectors-not-affected-at-end-of-monday
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Advisory: WannaCry
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Latest Global Ransomware - Petya
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https://krebsonsecurity.com/2017/06/petya-ransomware-outbreak-goes-global/
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Video: Ransomware

NUS Restricted

Source: ttps://www.youtube.com/watch?v=4gR562GW7TI&list=PLSJO6rbiqUDVe_I7QvGdrJnjOmaTqZfUR&index=20
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What should I do if my machines are infected?

NUS Restricted

Report to ITCARE

1 Disconnect the machines from network

2 Disconnect any storage devices from the machines

3 Report to your supervisor

4
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Answer: No, there is no guarantee that your files will be recovered.
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Ransomware File Decryptor

NUS Restricted

Reference: 
https://success.trendmicro.com/solution/1114221-downloading-and-using-the-trend-micro-ransomware-file-decryptor
https://id-ransomware.malwarehunterteam.com/

https://www.csa.gov.sg/gosafeonline/go-safe-for-me/homeinternetusers/ransomware-help-sheet
https://success.trendmicro.com/solution/1114221-downloading-and-using-the-trend-micro-ransomware-file-decryptor
https://id-ransomware.malwarehunterteam.com/
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Source: https://www.nomoreransom.org/en/decryption-tools.html

Ransomware File Decryptor
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Some Ransomware can Traverse across Network

NUS Restricted

Source: https://www.csa.gov.sg/singcert/news/advisories-alerts/ransomware

https://www.csa.gov.sg/singcert/news/advisories-alerts/ransomware
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Source: UC Santa Cruz Information Techology Services@ Sep 2015



Copyright © NUS 2017

Public

What are the Sources of Malware?

NUS Restricted

“Removable drives, flash memory 
devices, and network folders are 
commonly used for data 
transfer. When you run a file from a 
removable media you can infect your 
computer and spread the virus to the 
drives of your machine.”
~ kaspersky

Email Internet

“Software vulnerabilities are most 
common targets of hacker attacks. 
Vulnerabilities, bugs and glitches of 
software grant hackers remote access to 
your computer, and, correspondingly, to 
your data, local network resources, and 
other sources of information” ~ 
kaspersky

Source: https://www.csa.gov.sg/singcert/news/advisories-alerts/ransomware, https://support.kaspersky.com/viruses

https://www.csa.gov.sg/singcert/news/advisories-alerts/ransomware
https://support.kaspersky.com/viruses


Copyright © NUS 2017

Public
NUS Restricted

…Beware of Infected USB
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…Beware of Fake Apps

NUS Restricted

https://www.csa.gov.sg/singcert/news/advisories-alerts/fake-mobile-apps
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…Beware of Vulnerable Apps

NUS Restricted

http://thehackernews.com/2017/09/ccleaner-hacked-malware.html

…is a popular application with over 2 billion 
downloads, created by Piriform and 
recently acquired by Avast, that allows 
users to clean up their system to optimize 
and enhance performance

Affected users are strongly recommended 
to update their CCleaner software to 
version 5.34 or higher, in order to protect 
their computers from being compromised

Avast and Piriform have both confirmed 
that the Windows 32-bit version of 
CCleaner v5.33.6162 and CCleaner Cloud 
v1.07.3191 were affected by the malware.
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Best Practices
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What are the best practices?

NUS Restricted

Do not download the software from untrusted source.

1 Perform data backup regularly.

2 Keep your anti-virus software up to date.

3 Keep your Operating System and Software updated.

4
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University Virus Scanner
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Window OS Updates

NUS Restricted

Settings\ Update and Security
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Forgot to lock your screen? 
…Beware of key Logger

NUS Restricted

http://www.channelnewsasia.com/news/singapore/smu-law-student-jailed-2/2519788.html
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Window Screen Lock

NUS Restricted

Settings\ Personalization\ Lock Screen
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Prevent USB from being auto run on 
your laptop
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Source: https://www.techrepublic.com/article/how-to-disable-autoplay-and-autorun-in-windows-10/
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Edge          Browser  Settings

NUS Restricted

SN Settings Values

1 Password and Form Data Do not remember passwords and form data

2 Cookies Don’t allow third party cookies

3 Pop up blockers Block pop up (that often comes from advertisement)

https://privacy.microsoft.com/en-gb/windows-10-microsoft-edge-and-privacy

1 2 3

https://privacy.microsoft.com/en-gb/windows-10-microsoft-edge-and-privacy
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Turn off Remote Desktop Connection to your PC
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Note: This state disallows remote access to your computer. 

Control Panel->system->Remote Settings
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Disable File Sharing (SMB v1)
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Open Control Panel > Programs & Features > Turn Windows features on or off.
Make sure it is unchecked. Restart your computer.

Note: This is an obsolete components for shared access to files and printers and 
should be disabled. 



Copyright © NUS 2017

Public

Turn off Network Discovery

NUS Restricted

Note: This state disallows your computer to see other network computers and devices and 
disallows people on other network computers to see your computer. 
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Enable Data Execution Prevention (1/3)
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Open Control Panel > System > Advance System Settings 

Note: This ensures program are not run on unauthorized memory area
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Enable Data Execution Prevention (2/3)
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Open System Properties> Advance > Performance > Settings

Note: This ensures program are not run on unauthorized memory area
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Enable Data Execution Prevention (3/3)
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Open Performance Options > Data 
Execution Prevention 

Select the option, “Turn on DEP for all 
programs and services except those I 
select” . Leave the selection list empty 
and click on OK. 
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Disable Powershell (1/2) 

NUS Restricted

Open Control Panel > Program and Features >Turn Window 
Features on or Off

Source: https://www.csa.gov.sg/singcert/news/advisories-alerts/measures-for-
protecting-customers-personal-data
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Disable Powershell (2/2) 

NUS Restricted

Uncheck Windows Powershell 2.0 and click Ok

Source: https://www.csa.gov.sg/singcert/news/advisories-alerts/measures-for-
protecting-customers-personal-data
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Read Advisories
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1 https://nusit.nus.edu.sg/its/

2

https://www.scamalert.sg/

3 https://www.csa.gov.sg/singcert/news/advisories-alerts

http://www.straitstimes.com/tags/cyber-security

4
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Thank you! Every question you 
asked contributes to the FAQ list 

that we are building for NUS 
community.
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https://www.csa.gov.sg/singcert/news/advisories-alerts/fake-mobile-apps
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